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Design and Layout 

Three Generations of Web Sites 

• First Generation - Basic 

• Second Generation – Probably some level of interactivity 

• Third Generation – More multimedia; more opportunity for interaction  

 

Audiences 

Design with the end-user in mind. Who will view your site? 

• Internet – World wide web network  

• Intranet – Internal audience 

• Extranet – Customer access 

Audience may be non-technical. A non-technical audience will more than likely be 
made up of users that do not upgrade their browser frequently. These users will not 
be able to enjoy technologies that require a version 4.0 browser or higher. They also 
may have slower systems, making them more likely to have slower-loading images. 

Best delivery style = inverted pyramid style design is similar to that of a newspaper, 
highlighting most important information first. The user is given highlights of what is 
contained inside and can navigate to find out more if he chooses. 

• Design for screen resolution of 640 x 480 pixels. 

• The average person reads 25% slower from a monitor than from a printed 
page. 

• Metaphor  - Site that plays on other medium. For example, a page that looks 
like a newspaper or newsletter. 

 

Usability Testing 

Test for things like ease of navigation, broken links, dithering, etc. 

• Project must be near completion 

• Audience should not be members of the design team 

• Audience should have mixed technological background 

• All flaws and problems should be identified at this stage 
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Problems usually appear in the deepest levels of the site. Be sure your site is well 
planned and can be easily navigated at all levels. A common problem is that a user 
can get stuck at the end of what he thought was a navigation path. 

 

Navigation Concepts 

Unless necessary, keep the default colors for links. Users are accustomed to them. 

Do not rely on the “Back” button that comes with the browser. You should provide 
navigation links such as Back and Home on every page. 

A Site map is a diagram of your site with the locations and titles of pages. 

Do not count on the user to scroll down or to the right. Use text and images together 
to guide the eye in a natural way. Users are comfortable reading from left to right. 

If the page does not download in less than 10 seconds, you will have lost the user's 
attention.  Consider the following table when designing:  

 

Connection Time File Size Time File Size

Modem One Second 2KB 10 seconds 34KB 

ISDN One Second 8KB 10 seconds 150KB 

T1 One Second 100KB 10 seconds 2MB 

 

Mindmapping 

 

Mindmapping is a diagram of headings, subheadings, and sub-subheadings on paper 
in a logical, non-linear order. Essentially, mindmapping=brainstorming.  It is useful 
for organizing the content of your planned site in a non-linear way. You may begin 
your diagram by drawing the main page of your site and attaching related pages in 
logical “order” all around it. 

The web offers many benefits. Take advantage of them by figuring out how things 
relate to each other in a non-linear way. Have a graphical map of the site before you 
begin to build any pages.  
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Fonts 
Serifs 

• Decorative Strokes  

• Body Text 

• E.g., Times New Roman 

 

Sans Serifs 

• No Decorative Strokes 

• Headings 

• E.g. Arial 

 

Web Graphics 

Both Internet Explorer and Netscape Navigator support .gifs and .jpgs: 

 

• Gifs – Images load a little at a time. Displays 256 colors 

• Jpgs – Slow, long download. Displays 16.7 million colors 

• Png  - Best for compression. Must provide user a free plug-in to view 

• Gif89a - Animated gif. Frames replay 

 

Navigator and Explorer guarantee only 216 colors; all other colors will not be pure. 

 

Colors 

RGB Hexadecimal 
R=255 G=255 B=255 R=FF G=FF B=FF 

255-255-255=white FF-FF-FF=white 

 

Dithering – The image palette compromising with the abilities of the user’s system. 
Results in changes to intended color.   

Consider file size - 28.8 Kbps modems are still standard. Deep color increases file 
size.  
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Free graphics - All over the web you can find free graphics, but be careful to watch 
for copyright statements. Typically, high-quality graphics are not free.  

Alt attribute - Use the alt attribute for images for users who have disabled images on 
their browsers and also those viewers who require accessibility features. E.g. <img 
src=”file.gif” alt=”Picture goes here!”>. 

  

To create white space, use: 

• Borderless tables, or 

• Transparent gifs 

 

Multimedia 

Multimedia is the use of images, graphics, sound, video or other elements on a 
website.  

About half of your site should be multimedia. Your on-line version should contain 
50% less text than a printed version. 

If your multimedia requires a plug-in to view: 

 

• Make downloading the plug-in accessible from your site, and 

• Make it easy for them to get back to your site. 

 

Java – Requires a user to download the same file for every play, resulting in slow 
pages 

Plug-in – A user downloads the plug-in once and can view multimedia easily after 
that 

Lowest Common Denominator – Do not use technology (like multimedia) just 
because you can.  It must have a purpose. 

 

HTML  

Stands for Hypertext Mark-Up Language.   

An HTML file is a text document that is “marked-up” by embedded tags, or 
instructions. Browsers, like Internet Explorer and Netscape Navigator, interpret 
HTML. 

A mark-up language instructs computers how to format documents. 
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HTML files are used extensively because they are small files that exchange easily 
over any network, the Internet or an Intranet.  

 

The History of HTML  

Tim Berners Lee of MIT invented HTML. Ted Nelson invented hypertext itself in 1965. 
HTML evolved from other mark-up languages. 

 

• GML – General Markup Language. Created by IBM in the 1960s. 

• SGML – Standard Generalized Markup Language. Evolved from GML.  

• HTML – Hypertext Mark-Up Language. Evolved from SGML.  

 

Evolution of Standards 

• HTML 1.0 – First specification, able to support images. 

• HTML 3.0 – Never released 

• HTML 3.2 – Introduced support of tables and frames 

• HTML 4.0 – Style Sheets and accessibility features. Formatting tags (center, 
bold, etc.) are now discouraged. This information should go on style sheets 
instead. 

o Transitional HTML 4.0 – Supports new technologies, but will cooperate 
with old browsers that cannot read them 

o Strict HTML 4.0 – No extra tags, no deprecated tags, clean document 

o Frameset HTML 4.0 – For use with frames 

 

Tables 

Be able to create code for cells in complex tables.  

 

• rowspan - how many rows the cell contains 

• colspan - how many columns the cell contains 

 

To use a table as a page structure, you must make changes in two tags: <Table> 
and <Body>  
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Basic Table Tags 

<TABLE></TABLE> - begins and ends the table definition 

<TR></TR> -  table row definition 

<TH></TH> -  table header definition 

<TD></TD> - table data (contents) definition 

ALIGN= - Horizontal alignment within a cell 

VALIGN= - Vertical alignment within a cell 

WIDTH= - Width of a cell (in pixels or percent) 

ROWSPAN= Number of rows a cell spans  

COLSPAN= Number of columns a cell spans 

NOWRAP – Turns off word wrapping within a cell 

 

Frames 

Frames are used to display both static and dynamic content.  

To create frames, use the <frameset> tag. In this tag you must place the “rows” or 
the “cols” attribute to set the display of the frames. This tag must be placed 
immediately after the </head> tag.  

For example: <Frameset cols=“50%, 50%”> creates two equally sized horizontal 
frames.  

The values of columns and rows in framesets can be set in either pixels or 
percentages. If set in pixels, the frame is absolutely sized, and will not adjust to the 
user’s screen. 

The <frame> tag introduces each frame. It will always have the “src” attribute, 
which will tell the browser which html file will make up that frame. This is the 
process of targeting hyperlinks. Example: <frame src=”file.htm” name=”body”>. For 
this to work, htm files in your site must be named.  

If all the pages contained in the links you provide should be opened in the same 
frame, you should designate that in the <head> tag of your code:  

<base href=(url here) Target=”main”> 

To make one frame static, add “scrolling=”no” to your frame tag: 

<frame src=”file.htm” name=”body” scrolling=”no”> 
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HTML Tables vs. Frames  

• Tables can be easily bookmarked. Frames cannot. 

• Using Frames, you can keep one section static, for example, Contact 
Information that you would like to keep constantly visible. 

 

HTML Limitations 

• Heavily dependent on server, causing higher traffic to and from the server 

• Search engine overload (tags are formatted by style, which doesn’t help the 
search engine find a word in the text by subject) 

• Not extensible. Limited number of HTML tags 

 

For more information on HTML, check out our Novell Web Authoring Cramsession 

 

Metadata 

Metadata is the information about the content of your page contained in the <head> 
tag of your code. 

DTD – Document Type Definition - has information about which variation of HTML 
you are using. Identified by the tag <!doctype>. 

Two attributes: 

 

• <meta http-equiv> - Values that affect the browser. Associated with HTTP 
headers. Expiration dates, refresh, etc.  

• <meta name> - Values that do not affect the browser. Keywords, 
descriptions, etc.  

 

Cascading Style Sheets 

CSS are style definitions.  They are useful and allow you more control over the look 
and feel of a site.  

There are four ways to apply style sheets:  

 

• Linking to style sheets from you HTML file - External style sheets that can be 
used for multiple pages 

• Importing style information - Another method for accessing an external file 

http://cramsession.brainbuzz.com/cramsession/novell/WebAuthoring/
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• Embedding style information - Changing the styles contained on a page 

• Using an inline style - Style attributes can add definitions to existing HTML 
tags. E.g.: <H3 style=“color: red;font-size: 30pt”>Heading 3</h3> 

 

Software 

For the purpose of this exam, you should be familiar with and able to navigate in the 
following software: FrontPage 2000, Dreamweaver 3.0, Allaire HomeSite 4.5, JASC 
Paint Shop Pro 5.0, and Macromedia Flash 4.0. 

 

FrontPage 2000 

A WYSIWYG tool. 

Sites created in FrontPage need to be hosted by a server that supports FrontPage 
extensions to use the programming features.  

 

FrontPage Strengths  

• Page layout  

• Site management  

• Data connection 

 

FrontPage Views and Features 

• Page View – Displays the actual working page, in three formats: 

o Normal – Page as you edit 

o HTML – Code creating the look of your page 

o Preview - Page as a browser would present it 

• Folders View – Displays folders and files in a project 

• Reports View – Monitor all files, i.e. hyperlinks (broken, external, internal), 
slow-loading pages, errors in files, images, and themes. 

• Navigation View – Hierarchical map of site where each page is represented by 
a folder 

• Hyperlinks View – Details of a hyperlinks on a page. 

• Tasks View – Organize “to-do’s” for team members. 

To save a page as a template, select Save as Template from the File menu.  
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Two options for the page layout: 

1. Tables – Recommended option 

2. Cascading Style Sheets – Not supported on all browsers. Styles and themes 
are both applied using CSS: 

• Shared borders – Like frames, some content will remain static 

• Styles – Format text appearance 

• Themes – Base web on graphical themes 

You have the option to choose pre-created framesets in FrontPage, if you would like 
to design using frames. 

Three ways to create a table: 

1. Select Insert Table from the Insert menu 

2. Draw the table with the pencil tool 

3. Code in HTML. 

FrontPage can use images from  

1. Internet 

2. Your computer 

3. Working site 

 

DHTML in FrontPage 

No knowledge of DHTML is necessary to add DHTML features to your FrontPage site. 
To add features, select DHTML from the Format menu. From this menu, you may 
apply effects to an object if that effect is available.  

You may create and process forms in FrontPage with no programming knowledge. 

 Two ways to gather data from a user: 

• E-mail 

• Web form 

 

Macromedia Dreamweaver 3.0 

A WYSIWYG tool.  

Layers- tool used by Dreamweaver to organize site. 

• “Absolute positioning” (not supported by all browsers) 

• Convertible to tables 
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o Layers are comparable to tables. They are useful because they can be 
converted to tables.  

o The layer should be as close as possible in size to the size of the content 
of the layer.  

 

Dreamweaver Strengths 

• Absolute positioning using layers 

• Layer-to-table conversion 

• Able to import existing HTML without reformatting 

• DHTML effects 

To build a site in Dreamweaver, you must first choose the name of the site and the 
location of the local root folder. 

Objects and Properties are the most commonly used palettes in Dreamweaver. 

 

Dreamweaver Elements and Features 

• Page templates – Allow you to create consistent pages. You must choose 
certain regions to modify and the rest of the page will remain consistent 

• Layers – Put images or text exactly where you want it without the use of 
tables 

• Jump menu – Drop down menu that provides selections, links to URLs. 

• Behaviors – Add interactive elements to a site. 

• Macromedia Dreamweaver Exchange – Dreamweaver users can swap 
Dreamweaver Extensions.  

 

FrontPage vs. Dreamweaver 

• Both let you use a WYSIWYG, but also let you tweak by coding manually. 

• FrontPage offers server-side processing in form use. Dreamweaver does not.  

• Both let you use circles, polygons, and rectangles in the use of image maps. 
When a user clicks inside the shape in the picture, he will hyperlink to a 
designated URL. 

• FrontPage and Dreamweaver contain publishing tools. You do not need to 
purchase and learn other programs. 

• FrontPage allows you to transfer your files via either FTP or HTTP.  
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• Dreamweaver allows you to publish one file at a time.  

• Both create code for each browser. For instance, in using DHTML, FrontPage 
and Dreamweaver create code for each browser to read DHTML and code to 
tell the other browser to ignore code that it doesn’t understand. (See: section 
on Dynamic HTML). 

 

Allaire HomeSite 4.5 

An HTML Editor known for strong file management.  

 

Homesite Strengths 

• The default structure is a new HTML document with the necessary tags 
provided.  

• You must know HTML to use an HTML editor. It provides a wizard to assist in 
the creation of frames and tables, but in order to fix them at all, you must be 
able to code HTML.  

• To create a template in Allaire HomeSite, save the file as an .hst extended 
document.  

 

JASC Paint Shop Pro 5.0 

A web-graphic image-editing application. 

 

JASC PSP Strengths 

• You can use the Undo button an unlimited niumber of times. 

• The Filter Browser feature lets you preview filter effects quickly and easily. 

• The number of colors should be set to 16.7 million. 

• A floating palette is a tool palette that you may move around.  

 

Macromedia Flash 4.0 

A Software application used to create and view multimedia.  Preceded by 
Macromedia Director. The upgrade made files easier to compress. 

 

Flash Features 

• Timeline 
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• Layers 

• Vector graphics 

• Streaming Capability 

 

Flash is embedded into the HTML code:  

o <object> tag in Internet Explorer 

o <embed> tag in Netscape Navigator 

• Fills - The elements that Flash allows you to add, such as colors, images, or 
palettes. 

• Timeline - The bar under the flash player that controls motion of movie, speed 
of play, pauses and stops.  

• Layers – Run more than one animation at the same time.  

• Create a symbol in flash by naming it and designating it as a symbol. 

• Movie clips are symbols developed in Symbol Edit.  

• Tell Targets – Assign an action or event to an object other than a button. 

• Mask – Cover some area, allowing a specified region to show through. 

 

Basic Types of Frames 

• Normal – Content comes from a preceding frame with no changes. 

• Key – Contains objects to be displayed in all frames to follow. 

• Blank Key – New content can begin from here. 

 

Tweens 

The ability of Flash to show motion and animation. 

• Motion Tween – Objects move to another position on screen. 

• Shape Tween – Objects transform to different images on screen. 

 

JavaScript 

An object-based scripting language created by Netscape. JavaScript adds 
interactivity to a web site without using server-side applications. 

JavaScript must be placed into an HTML document using the <script> tag. 
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Functions are triggered by events.  

 

Terminology 

Object – think of noun (thing) 

Method – think of verb (action) 

Property – think of adjective (attribute) 

 

Tips: 

Person.read() = method 

Src=”file.gif” = property of object 

 

JavaScript Strengths 

• Quick development 

• Easy to learn 

• Platform independent 

Dot notation – Syntax used to associate an object’s name with its properties or 
methods.  

 

For more information on JavaScript, check out our CIW JavaScript Fundamentals 
Cramsession and Sun Java Programmer Cramsession  

 

Dynamic HTML 
A group of technologies that behave like HTML with the ability of dynamic 
functionality. 

Incorporates several technologies: 

 

• Script 

• Document Object Model (DOM) – A hierarchy developers use to structure and 
manipulate content 

• HTML 4.0 and CSS (working together) 

http://cramsession.brainbuzz.com/cramsession/Prosoft/Ciw_JavaScript/
http://cramsession.brainbuzz.com/cramsession/Prosoft/Ciw_JavaScript/
http://cramsession.brainbuzz.com/cramsession/Sun/java2/
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DHTML could conceivably replace Active Server Pages because it provides dynamic 
content to the browser rather than static HTML, without the need to access servers 
each time.  

 

DHTML Limitations 

• Not currently supported by both browsers in any pure form. IE and Netscape 
accept different code to create DHTML. 

• W3C has not yet supported standard tags for creating DHTML. 

 

XML and XSL are expected to advance and offer DHTML features and more. 

DOM – An expanded DOM could be the solution for DHTML’s incompatibility with 
some browsers. Currently, if a non-compatible browser reads DHTML, the browser 
may crash. 

For more information on Dynamic HTML, check out An Introduction to DHTML 

 

XML 
Stands for Extensible mark-up language. Derived from the meta-language SGML, 

XML is strict. A single error will keep the page from appearing. 

• XML is a meta-language that makes documents “intelligent.” This means the 
mark-up tags are more explicit in terms of the document’s content. 

• Coders can define their own set of mark-up tags. 

• Created at W3C to define structure and content. 

• All elements must be opened and closed:  

HTML 

<li> item 

<li> item 

XML 

<li> item </li> 

<li> item </li> 

 

• All attributes must be contained in quotations. 

• All layers of code must be contained within one another:  

http://www.webdevelopersjournal.com/articles/dhtml1/dhtml1.html
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<Name>First Name<Surname>Last name</Surname></Name> 

• XML Tags are case-sensitive. 

XML documents are useful for documents that may be used again and may be 
subject to searches.     

 

For more information on XML, check out A Look at XML and the W3C XML Page 

 

HTTP Servers 

Web Servers present documents to a browser when requested. 

A port is a connection point. Port numbers range from 0 to 65,536, though numbers 
0 through 1024 are reserved.  

The default port for HTTP servers is 80. 

The default port for Secure Sockets Layer (SSL) is 443. 

Apache is the most popular server. It is free and can run on most operating systems.  

 

Cookies 
Small text files sent from server to a browser to store information on a user’s 
computer.  

• Cookies cannot: 

o Read hard drive files 

o Retrieve passwords 

o Contain viruses 

• Cookies are stored in one place on your computer.  

• You can delete cookies from your system and configure your browser to warn 
you before accepting cookies. 

 

Plug-Ins 

Plug-ins are programs that allow users to view files the browser does not support as 
part of an HTML document.   

If you include anything that a browser cannot view (some multimedia, for instance), 
it is good practice to provide a way for the user to view your include.  

http://www.webdeveloper.com/xml/xml_a_look_at_xml.html
http://www.w3.org/XML/http://www.w3.org/MarkUp/
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Three ways to provide plug-in: 

• Online 

• Offline (Download and launch) 

• Pre-installed on browser 

o You may include a downloadable file on your site by linking to a file type 
not supported by a browser. You should provide the file type and file size. 

o You must provide ways for the user to download and install any plug-in 
needed to view your site effectively.  

 

Adobe Acrobat Reader 

A Free download that reads Portable Document Format files (.pdf files).  A .pdf file 
maintains its format integrity across all platforms.  

 

Streaming Technology 

A File that starts playing audio or video as soon as the server is reached.  

 

Java Applets 

A Small, fast, platform-neutral mini-application that runs on the client side. 

To insert an applet into a page, you must know the class file location and 
parameters.  

Applets are referenced as: 

<applet> tag in HTML 3.2 

<object> tag in HTML 4.0 

 

Limitations 

• No streaming capability (entire file must be downloaded before it is 
functional) 

• No caching ability (must be re-downloaded each time the user visits the site) 

 

Databases 

Enable File storage. 
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• The structure of a database is called the schema. 

• Queries are requests that a user makes to the database. 

• In a database table, columns and rows are known as “fields” and “records,” 
respectively.  

 

Language Generations 

1st Generation – Machine language 

2nd Generation – Assembly language 

3rd Generation – Programming language 

4th Generation – Most closely resembles verbal language 

 

SQL 

Stands for Structured Query Language.  

• Developed by IBM in 1974  

• 4th Generation Language 

• Current standard for accessing databases 

 

DBMS 

Stands for Database Management System.  

• Flat-file – Single table 

• RDBMS – Relational Database Management 

• Multidimensional – Groups of Records 

 

ODBC 

Stands for Open DataBase Connectivity 

Method to access a database regardless of which DBMS or application program is 
used. 

 

Internet Organizations 

Organizations that govern different aspects of the Internet. 
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• Internet Society (ISOC) – Heads the groups responsible for Internet 
infrastructure standards, including the IETF and the IAB. Created as legal 
umbrella for IAB. http://www.isoc.org  

• Internet Architecture Board (IAB) – Technical advisory group that makes 
recommendations to the ISOC. http://www.iab.org  

• Internet Research Task Force (IRTF) – Long-term issues surrounding the 
Internet. Concerned with protocols. http://www.irtf.org  

• Internet Engineering Task Force (IETF) – Short-term technical advisory board. 
http://www.ietf.org  

• World Wide Web Consortium (W3C) – Creates recommendations for 
languages and technologies. Directed by Tim Berners-Lee. Vendor neutral. 
http://www.w3.org  

• Internet Corporation for Assigned Names and Numbers (ICANN) – Formed, 
1998. Responsible for IP address, domain name system management. ICANN 
oversees the accreditation of domain name registrars. http://www.icann.org 

 

Requests for Comments (RFCs) – The IAB publishes the RFCs. It allows users the 
opportunity to provide input. RFCs are listed by number at http://www.rfc-editor.org.  
When an RFC is declared a standard, the RFC remains an RFC with the same 
number.)  

 

Web Site Publishing 

Transferring your site to the World Wide Web. 

You can host your site in two ways, in-house or contract an ISP (Internet Service 
Provider). When you host in-house, the greatest benefit is complete control of the 
site.  

 

Things to consider: 

• Cost 

• Speed 

• Reliability 

To publish a web site you need: 

• Address of the server 

• User name 

• Password 

http://www.isoc.org/
http://www.iab.org/
http://www.irtf.org/
http://www.ietf.org/
http://www.w3.org/
http://www.icann.org/
http://www.rfc-editor.org/
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FTP – File Transfer Protocol. Used to transfer files between a computer and a server.  

WS FTP Pro is reliable and downloadable for free. You can publish one file at a time. 
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